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Overview 

This guide contains technical installation and setup information for the staff at your company who 
maintain the hardware and software required to install Deltek Vision 6.1. 

About This Guide 
This guide contains the information that you need to install the various components of the 
Performance Management Canvas software. We revise this document regularly to provide the 
most up-to-date technical information and instructions. Visit the Knowledge Center tab of the 
Deltek Customer Care Connect site, https://support.deltek.com, to determine if your copy is the 
latest copy, and to download the most recent copy if necessary.  

Customer Services 
For over 20 years, Deltek has maintained close relationships with client firms, helping with their 
problems, listening to their needs, and getting to know their individual business environments. A 
full range of customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 
  

 
Find out more about these and other services from the Customer Care Connect site. 

  

Customer Care Connect Site 
The Deltek Customer Care Connect site is a support Web portal for Deltek customers who 
purchase an Ongoing Support Plan (OSP).  

The following are some of the many options you have at the Customer Care Connect site: 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through 
the Deltek Connect Customer Forums 

 Display or download product information, such as release notes, user guides, technical 
information, and white papers 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 Subscribe to Deltek communications about your Deltek products and services 
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 Receive alerts of new Deltek releases and hot fixes 
  

 If you need assistance using the Customer Care Connect site, the online help available on the site 
provides answers for most questions 

  

Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps:  

1. Go to https://support.deltek.com.  

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 
  

 

If you do not have a username and password for the Customer Care Connect site, contact your firm’s 
System Administrator. 

If you forget your username or password, you can click the Account Assistance button on the login 
screen for help. 
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Additional Installation Documentation  
The following table lists the additional Deltek installation documentation available for this release. 
Except where noted, all the user guides and quick reference guides listed in this table are 
available for download from the Deltek Customer Care Connect site (http://support.deltek.com). 

Document Name Description 

Deltek Vision Document 
Management Technical Installation 
Guide 

This guide contains detailed information on the 
necessary prerequisites, general configuration, and 
installation procedures required to use the Vision 
Document Management application. 

Deltek Vision Mobile Application 
Suite (MAS) Installation Guide 

This guide explains how to configure MAS on your Vision 
server, install prerequisite software components, and 
install and configure the MAS software. This guide also 
provides a list of all the mobile devices that can be used 
with the Deltek Vision Mobile Application Suite. 

Deltek Vision Synchronization 
Server Installation and Maintenance 
for Nokia Intellisync 

This guide contains an overview of the Vision 
Synchronization Server feature, as well as technical 
installation, setup, and maintenance information. 

Deltek Vision 6.1 Custom Reports 
and Microsoft SQL Server® 
Reporting Services 

This guide provides information for performing the tasks 
that are necessary to create, deliver, and generate 
Vision custom reports. You must use SQL 2005 
Reporting Services design tools to modify existing Deltek 
Vision reports or to display your custom reports within 
the Vision framework.  

To obtain the SQL 2005 Reporting Services design tools 
(BIDS), you must download SQL 2005 Express Tools 
(http://www.microsoft.com/Sqlserver/2005/en/us/express-
down.aspx#tool). 

Deltek Vision Creating a Reverse 
Proxy for SQL Reporting Services 
Using IIS 7.0 Application Request 
Routing (ARR) 

This guide contains instructions for configuring a reverse 
proxy that utilizes Microsoft’s Application Request 
Routing (ARR) extension for IIS 7.0. This allows the 
direct forwarding of requests through the Vision Web 
server to the reporting services Web service with 
responses back to your Internet clients. 

Deltek Vision 6.1 Connect for 
Microsoft Outlook Installation Guide 

 

This guide provides information for installing Deltek 
Vision Connect for Microsoft Outlook onto your Vision 
Web Server. It also provides details on installing, 
implementing, and configuring user workstations. 
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Chapter 1: Install Performance Management 
Canvases 

Overview 
With Performance Management Canvases, you can use Vision Project Cubes and General 
Ledger Cubes data sets and analysis services to create role-based graphical canvases. These 
canvases offer a customized graphical component for the Vision Dashboard.  

You must complete the installation steps in this chapter to use Performance Management 
Canvases with Vision.  

Logical Tier Model 
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Deploy Deltek Vision (6.1 Cubes) 

Before You Begin 
Before you install the Performance Management Canvas software, you must configure the Vision 
Analysis Cubes. Data for the canvases is based on the Vision Analysis Cubes, not the Vision 
database. See Configure Vision Analysis Cubes on Customer Care Connect for more information. 

The following prerequisites must also be met: 

 Minimum hardware requirements — 2.0 GHz processor and 2.0 GB RAM  

 Performance Canvas Server — Windows Server 2003 / 2008 - (x86 or x64) or Windows 
Server 2008 R2 (x64) 

 Microsoft OLAP Data Pump Server — Windows Server 2003/IIS 6.0/ Windows Server 
2008/IIS 7.0 (x86 or x64) or Windows Server 2008 R2/IIS 7.5 (x64) 

 OLAP Server — SQL Server Analysis Services 2005 / 2008 (x86 or x64) 

 Internet Explorer 8 (or higher) is highly recommended on client workstations that will 
access the Performance Management Canvases. 

Identify Deployment Strategy 
Before you install the Performance Canvas software, you must consider the following: 

 Where will you install the Performance Canvas software? 

 Where will you install the Microsoft OLAP data pump? 

 What type of security will you use? 

 Will the Performance Management dashparts be accessed by Internet clients? 

Where will you install the Performance Canvas software? 
When you install the Performance Canvas software on a server, you must consider the following: 

 The amount of available RAM and CPU usage on the servers. Because the Performance 
Canvas software caches the cubes for performance, memory can reach more than 500 
MB and CPU usage can be significant. If you install Performance Canvas on servers with 
existing workloads, ensure that you have adequate CPU and memory available for all 
processes. 

 The number of Performance Management Canvas users. As the number of users 
increases, so will the memory and CPU utilization on the Performance Canvas server. 

 The size of the Vision Analysis Cubes database. Because the Performance Canvas 
software caches data, cube size directly impacts the amount of memory used on the 
server. 

Where will you install the Microsoft OLAP Data Pump? 
The Microsoft OLAP Data Pump is a web server extension installed in IIS. The Performance 
Canvas software uses the data pump to communicate with the cubes on the SSAS server. 

Deltek recommends that you install the Microsoft OLAP Data Pump on the server that hosts the 
Performance Canvas software. However, you can install the Microsoft OLAP Data Pump in one of 
the following places: 
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 Install on the SQL Server Analysis Server (SSAS). If you install on this server, you must 
also configure IIS on this server. Deltek does not recommend this installation if your 
Vision deployment requires access via the Internet. 

 Install on the Performance Canvas server. You must also:  

1. Configure IIS on that server. 

2. Install pre-requisite software on that server. 

3. Change the Performance Canvas server port default (80), which conflicts with IIS. 
Typically, a port between 81 and 89 is available on your server but any available port 
is sufficient.  

 Install on another server. You must also: 

1. Configure IIS on that server. 

2. Install pre-requisite software on that server. 

What type of security will you use?  
You must configure two types of security:  

 Performance Canvas Security 

o How will users authenticate to the Performance Canvas software? 

o Performance Canvas roles – what level of access will users have to the 
Performance Canvas software? 

 Microsoft OLAP Data Pump Security – How will the IIS virtual directory be secured? 

Security options are discussed in detail in the “Configure Security” section later in this document. 
You do not need to change the security model used with Vision to implement the Performance 
Canvas software.  

Will Performance Canvas Software / Vision Web Dashparts need to be 
accessed by Internet clients? 
If your current deployment allows users to access Vision directly via the Internet (not VPN), and 
the Performance Management Canvas web dashparts also need to be accessible by clients 
connecting via the Internet, you must complete the following actions: 

 Configure your firewall to allow the port being used by the Performance Canvas software 
to be accessed.  

 Establish an Internet accessible Fully Qualified Domain Name (for example, 
http://performancecanvas.company.com) for this access which will need to be resolved 
both inside and outside the corporate network. 
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Install Performance Canvases 
Prerequisites: 

Vision 6.1 Service Pack 4 
HotFix # 30 installed 

  

 
With the release of HotFix # 30 for Deltek Vision 6.1 SP4, Performance Canvas 07, 
version 1.3.0.7 will no longer be supported in favor of the newly supported Performance 
Canvas 09, version 2.3.213. This hotfix provides the necessary application updates to 
allow for migration to this new Performance Canvas platform. This document provides the 
information required to either upgrade your installation of Performance Canvas 07 to 09, 
or to perform a new installation of Performance Canvas 09.  

If you are currently running Performance Canvas 07 with Vision 5.1, you must upgrade to 
Vision 6.1 SP4 with hotfix # 30 to use Performance Canvas 09. 

  

NOTE: To upgrade our installation of Performance Canvas 07 to 09 follow the steps in the 
section titled Upgrade Performance Canvas Software on page 13. 

To perform a new installation of the Performance Canvases, complete the following steps: 

1. If necessary, upgrade your Vision installation to Vision 6.1 Service Pack 4 with HotFix 
#30.  If do not have the proper version installed you will not be able to use Performance 
Canvas 09. 

2. Download the Performance Canvas 09 setup from the Deltek Software Distribution site. 

3. Double-click the setup to run the Performance Canvas installation wizard. The 
Introduction page displays.  
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4. Click Next. The End-User License Agreement page displays. 

 

 

5. Accept the license and click Next. The Choose Setup Type page displays.  
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6. Select Custom as the setup type. 

7. Click Next to continue. The Custom setup page displays. 
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8. Change the location for the installation (if appropriate). 

9. Click Next to continue. The Ready to Install page displays. 

 

 

 

10. Click Install. The installation process runs. When complete, the Installation Complete 
page displays. Click Finish to finish the installation process. 
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Post Installation Steps 
After you install Performance Canvas, you must complete the following actions: 

 Identify the port Performance Canvas will use. 

 Modify the memory settings of Performance Canvas. 

 Install the Performance Canvas Windows Service. 

Identify the Port to Use 
Before you continue, you must identify the correct port: 

 If the Microsoft OLAP Data Pump and SSAS will not reside on the same server, see Data 
Pump and SSAS are Not on the Same Server on page 24. 

 If Performance Canvas and OLAP Data Pump are on the same server, you must modify 
the Performance Canvas zenith.properties file to change the default Performance 
Canvas port because both IIS and Performance Canvas will try to use port 80 as the 
default port. 

To identify the port, complete the following steps: 

1. Open Windows Explorer and browse to the location where Performance Canvas was 
installed. This location was selected in Step 4 of the Install Performance Canvases 
Chapter 1: Install Performance Management Canvasesprocedure (for example, in the 
previous procedure: C:\Program Files\Performance Canvas). 

2. Open Notepad and then use it to open the zenith.properties text file. 



Chapter 1: Install Performance Management Canvases 

 

Performance Management Technical Installation Guide 12 

 

3. Change the dsp.port value from the default port (80), which conflicts with IIS. Typically, 
a port between 81 and 89 should be available on your server but any available port will 
be sufficient. 

Modify Memory Settings 
By default, Performance Canvas configures the minimum and maximum memory for the 
application to use.  

To modify memory settings, complete the following steps: 

1. Open Windows Explorer and browse to the location where Performance Canvas was 
installed (in the previous example: C:\Program Files\Performance Canvas).  

2. Open the \bin folder. 

3. Open Notepad and use it to open the service.properties text file. 

4. Modify the following settings: 

 dsp.service.minmem=128M: change to 256M 

 dsp.service.maxmem=512M: change to 1024M 

Install the Performance Canvas Windows Service 

To install the Performance Canvas Windows service, complete the following steps: 

1. Locate the \bin folder where service.properties is located, and double-click 
InstallService.bat. The Performance Canvas service installs. 

2. Click Start » All Programs » Administrative Tools » Services and open Services 
MMC. 

3. Locate the Performance Canvas service and set the service to start automatically: 

 Double-click the service. 

 Set the Startup Type to Automatic. If Performance Canvas is installed to the same 
server as SSAS, you should leave the service as Manual and manually start the 
service upon reboot. SSAS must be available when the Performance Canvas service 
starts. 
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Upgrade Performance Canvas Software 
Prerequisites: 

Vision 6.1 Service Pack 4 
HotFix # 30 installed 

If you are running Vision with Performance Canvas 07, you must upgrade to Vision 6.1 SP4 with 
HotFix # 30 in order to use Performance Canvas 09.   

  

 
The upgrade process is not really an upgrade process from a software installation 
standpoint. Instead, you either uninstall Performance Canvas 07 after backing up the 
necessary Performance Canvas objects or you can perform a side by side installation if 
you wish to compare the two versions. Both of these options do require a clean 
installation of Performance Canvas 09 as detailed later in this section. 

  

NOTE: If you have configured load balanced Performance Canvas servers with a shared store 
path refer to Appendix B on page 48 for specific upgrade instructions. 

Option #1 - Uninstall Performance Canvas 07 
1. Uninstall the Performance Canvas 07 service as the 09 installation will install the same 

service name and will conflict. Make sure to make note of the service account and other 
pertinent configuration information (security and role configuration, etc.) before 
performing the uninstall. 

a. Stop the Performance Canvas service. 

b. Browse to the location of the Performance Canvas 07 installation directory 
(typically c:\Program Files\Performance Canvas). 

c. In the \bin directory, double-click the Uninstall.bat file to perform the uninstall of 
the service. 

d. Review the Services.mmc to ensure the Performance Canvas service is 
removed. 

2. Back up the Performance Canvas 07 installation directory (\Program Files\Performance 
Canvas). 

3. Uninstall Performance Canvas 07 from add/remove programs (Server 2003) or Programs 
and features (Server 2008). 

4. Make sure the installation directory is completely removed. If not, delete the Performance 
Canvas directory. 

5. Perform new installation of Performance Canvas 09 (refer to Install Performance 
Canvases on page 7). 

6. After the installation is complete, make of copy of the Store directory under the 
Performance Canvas installation directory. 

7. Make a copy of the zenith.properties file from the new installation.   

8. From the backup of Performance Canvas 07 completed in Step 2, complete the following: 

a. Copy the zenith.properties file as this file contains your license key information. 

b. Copy over the following directories from the backup \Store folder to \Performance 
Canvas\store, over-writing when prompted: 

 annotation 
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 canvas 

 chart 

 filter 

 gem 

 slicer 

 table 

 tag 

 viewpoint 

Additionally, copy over the store\settings\cubes.xml. This contains your datasource 
configuration. 

9. Uninstall and then reinstall the Performance Canvas 09 service. 

a. Stop the Performance Canvas service if it is started. 

b. Uninstall the Performance Canvas 09 service by double-clicking bin\uninstall.bat 

c. Modify the Memory Settings for the service as outlined on page 12. 

d. Reinstall the Performance Canvas service. 

10. Modify the following zenith.properties settings as appropriate for your installation. For 
example, modify the dsp.port value to the port used by Performance Canvas 07. 

11. Configure the service account for Performance Canvas to be the same account used for 
Performance Canvas 07. 

12. Start the Performance Canvas 09 service. 

13. Launch the Admin console for Performance Canvas 09 to configure your installation 
including the following. Refer to Configure the Performance Canvas Software on page 26 
for more information: 

a. Configuring security (NTLM v. Anonymous) 

b. Adding users to roles (make sure to add your admin account and the service 
account to the Administrators role) 

c. Verifying datasource configuration (cubes.xml) 

d. Verifying canvas approvals 

Option #2 – Perform Side by Side Installation 
 

1. Uninstall the Performance Canvas 07 service as the 09 installation will install the same 
service name and will conflict. Make sure to make note of the service account and other 
pertinent configuration information (security and role configuration, etc.) before 
performing the uninstall. 

a. Stop the Performance Canvas service. 

b. Browse to the location of the Performance Canvas 07 installation directory 
(typically c:\Program Files\Performance Canvas). 

c. In the \bin directory double-click the Uninstall.bat file to perform the uninstall of 
the service. 
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d. Review the Services.mmc to ensure the Performance Canvas service is 
removed. 

2. Back up the Performance Canvas 07 installation directory (\Program Files\Performance 
Canvas). 

3. Perform a new “custom” installation of Performance Canvas 09, making sure to change 
the installation location to \Program Files\Performance Canvas 2009 and not overwrite 
your 07 installation (refer to Install Performance Canvases on page 7). 

4. After the installation is complete, make of copy of the Store directory under the 
Performance Canvas installation directory. 

5. Make a copy of the zenith.properties file from the new installation.   

6. From the backup of Performance Canvas 07 completed in Step 2, complete the following: 

a. Copy the zenith.properties file as this file contains your license key information. 

b. Copy  the following directories from the backup \Store folder to \Performance 
Canvas\store, overwriting when prompted: 

 annotation 

 canvas 

 chart 

 filter 

 gem 

 slicer 

 table 

 tag 

 viewpoint 

Additionally, copy the store\settings\cubes.xml. This contains your datasource 
configuration. 

7. Uninstall and then reinstall the Performance Canvas 09 service. 

a. Stop the Performance Canvas service if it is started. 

b. Uninstall the Performance Canvas 09 service by double-clicking 
bin\uninstall.bat. 

c. Modify the Memory Settings for the service as outlined on page 12. 

d. Reinstall the Performance Canvas service. 

8. Modify the following zenith.properties settings as appropriate for your installation. Make 
sure to choose a port that is different from Performance Canvas 07 so they will not 
conflict (for example,  if 07 is using port 81, configure 09 to use port 82). 

9. Configure the service account for Performance Canvas to be the same account used for 
Performance Canvas 07. 

10. Start the Performance Canvas 09 service. 

11. Launch the Admin console for Performance Canvas 09 to configure your installation 
including the following: 

a. Configuring security (NTLM v. Anonymous). 
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b. Adding users to roles (make sure to add your admin account and the service 
account to the Administrators role). 

c. Verifying datasource configuration (cubes.xml). 

d. Verifying canvas approvals. 

Additional steps for side by side comparison after Performance Canvas 09 installation: 

12. Modify the Performance Canvas 07 service.properties file to make service 
name/description unique. 

dsp.service.name=Performance Canvas 2007 

dsp.service.description=Performance Canvas <version> 

dsp.service.minmem=128M 

dsp.service.maxmem=1024M 

13. Re-install the Performance Canvas 07 service by double clicking InstallService.bat in the 
Performance Canvas 07 installation directory. 

14. Start Performance Canvas 07 service. 

Once you have completed your comparison of Performance Canvas 07 and 09, stop and uninstall 
the Performance Canvas 07 service and uninstall the software (if appropriate). 
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Install/Configure Microsoft OLAP Data Pump 
The Microsoft OLAP Data Pump is a web server extension installed in IIS which the Performance 
Canvas software uses to communicate with the cubes on the SSAS server. You must install and 
configure the Microsoft OLAP data pump before Performance Canvas can communicate with the 
cubes. See the Microsoft documentation on how to install and configure the data pump in IIS 6.0 
(Windows Server 2003: http://technet.microsoft.com/en-us/library/cc917711.aspx?ppud=4). 

If you use IIS 7.0 (Windows Server 2008),follow the steps outlined below: 
  

 Your installation of SQL Analysis Services and the platform chosen for the OLAP Data 
Pump (IIS) must be the same platform architecture (for example, they must both be x86 
(32-bit) or x64 (64-bit)). 

  

The following instructions update the SQL 2005 documentation to work with IIS 7.0 / IIS 7.5 when 
you are installing/configuring the Microsoft OLAP Data pump: 

Overview 
Microsoft® SQL Server™ 2008 Analysis Services uses the same architecture for providing HTTP 
access as did SQL Server 2005 Analysis Services.  

The pump component is loaded into IIS (Internet Information Services) and serves as an ISAPI 
extension, to pump data from the client to an Analysis Services server and back. 

This appendix explains how to set up HTTP access to Analysis Services when you use Microsoft 
Windows Server™ 2008.  

 

 

Figure 1 provides a high-level overview of the component architecture.  

Step 1: Get Binaries 
Copy the contents of the %Installation folder%\OLAP\bin\isapi directory into the folder you 
would like to become the base for the virtual directory in IIS.  

In this example, we copy all the files from the C:\Program Files\Microsoft SQL 
Server\MSSQL.1\OLAP\bin\isapi folder into the C:\inetpub\wwwroot\olap directory.  

 To take advantage of the full set of security settings, it is important to make sure that the 
folder to become the base for the virtual directory is located on the drive formatted for the 
NTFS file system. 

 Due to IIS limitations, the path to your directory must not contain spaces. 

 As in SQL 2005, if you plan to run the HTTP pump on a different server than the Analysis 
Services server, make sure that you also install OLE DB for Analysis Redistributable 
package. This also requires MSXML 6.0. You can obtain these files from the following 
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Microsoft site: 
http://www.microsoft.com/downloads/details.aspx?familyid=228DE03F-3B5A-428A-923F-
58A033D316E1&displaylang=en 
NOTE: You must download the correct platform for your installation (x86 or x64). 

Step 2: Create an Application Pool 

To create an application pool, complete the following steps: 

1. Click Start » All Programs » Administrative Tools to open the Internet Information 
Services (IIS) Manager. 

2. In the IIS console, expand the Server Name node and then click Application Pools. 

3. Right-click the Application pools to open the shortcut menu and select Add Application 
Pool. 

4. Name the application pool. In this example, we call it OLAP. 

5. Select .NET Framework v2.0.5027 as the .NET Framework version and Classic as the 
Managed pipeline mode. 

 

Step 3: Create a Virtual Directory 

To create a virtual directory, complete the following steps: 

1. While still in the IIS console, expand Sites and then Default Web Site (or whatever the 
site name is that you are using). 

2. Right-click the Web site and select Add Application.  

3. Name the virtual directory. In this example, we call it OLAP. 
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The Content Directory must point to the folder you created. In this example, it is 
C:\inetpub\wwroot\olap. 

4. Click OK to create the application. 

5. Click the OLAP virtual directory and then select Handler Mappings. 

 

6. Double-click Handler Mappings and then Edit Feature Permissions in the right hand 
Actions menu: 
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7. Select the Read and Script permissions, if they are not selected. 

8. Click Actions » Add Script Map. 

9. Enter *.dll as the Request path, then browse to the location of the msmdpump.dll file and 
enter OLAP as the name. 

 

10. Click OK to accept the settings. The following message displays asking if you want to 
enable the ISAPI extension. 
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11. Select Yes to accept the settings. 

12. To see the ISAPI extension that was added, click the Server Name node in the IIS 
console and double-click ISAPI & CGI Restrictions. 

 

13. Double-click OLAP Data Pump. 
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Step 4: Configure Security 

To configure security, complete the following steps: 

1. Select the OLAP virtual directory. 

 

2. Double-click Authentication. 

 

If you use Anonymous Access for IIS, complete steps 3 through 7. If you use Windows 
Integrated Authentication for IIS, complete steps 8 through 11. 

Anonymous Access for IIS: 

3. Select Anonymous Authentication. 

4. Click Actions » Enable. 

5. Click Edit and configure an SSAS account that has read access to the cubes: 

 

6. Select Windows Authentication. 

7. Click Actions » Disable. 
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Windows Integrated Authentication in IIS: 

8. Select Anonymous Authentication. 

9. Click Actions » Disable. 

10. Select Windows Authentication. 

11. Click Actions » Enable. 

Step 5: Select the Target Analysis Services Server  
As you can see in the architectural diagram in Figure 1, every pump component uses its own 
configuration file. 

Open the msmdpump.ini file in your folder and take a look at the contents of this file. It should 
look like the following: 

<ConfigurationSettings> 

<ServerName>localhost</ServerName> 

<SessionTimeout>3600</SessionTimeout> 

<ConnectionPoolSize>100</ConnectionPoolSize> 

<MinThreadPoolSize>0</MinThreadPoolSize> 

<MaxThreadPoolSize>0</MaxThreadPoolSize> 

<MaxThreadsPerClient>4</MaxThreadsPerClient> 

</ConfigurationSettings> 

The only setting you are interested in at this point is <ServerName>. 

If the Analysis Services instance to which you must provide access is located on the local 
machine and installed as a default instance, there is no reason to change this setting. Otherwise, 
you need to specify the machine name and instance name (mymachine\inst1). 

It is also possible to specify a pointer to the virtual directory on another IIS server that is set up for 
HTTP access to Analysis Services. For example: 

 <ServerName>http://secondmachine/olap/msmdpump.dll</ServerName> 

Step 6: Get it All Together 
At this point, your HTTP pump is configured and you can connect from your application. 

If your application provides you with a way to specify the server name, substitute your server 
name with the path to your virtual directory concatenated with “msmdpump.dll”. 

As in SQL Server 2005 Analysis Services, the MSOLAP OLEDB provider understands that the 
server name includes a URL path and automatically starts with the HTTP protocol.  

For example, to connect to “MyMachine” from the MDX sample application, you use the following 
to connect to the Analysis Services server: 

http://MyMachine/olap/msmdpump.dll 

After you install the Microsoft OLAP Data Pump, you must complete the following actions: 

 Configure IIS Security. 

 Configure settings, if the Data Pump and OLAP are not on the same server.  

 Test the Data Pump configuration. 
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Configure IIS Security 
You must configure IIS security by modifying the Directory Security permissions on the OLAP 
virtual directory. The steps to configure this in IIS 6.0 follow. Appendix A outlines these steps for 
IIS 7.0. 

To configure security, complete the following steps: 

1. Right-click the OLAP virtual directory in IIS and select Properties. 

2. Click the Directory Security tab. 

3. Click the Edit button under Anonymous Access and Authentication Control. 

4. Select either Anonymous Access or Windows Integrated Authentication, then make 
the appropriate additional modifications: 

 Anonymous Access — You must change the IIS Anonymous Access account to an 
account that has read access to the cubes. 

 Windows Integrated Authentication — You must change the Performance Canvas 
service account to an account that has read access to the cubes. This is the 
recommended configuration. 

If you will use Windows Integrated Authentication for the Microsoft OLAP Data Pump 
virtual directory, set the Performance Canvas service to run as a domain user that 
has read access to the cubes. This user needs the log on as a service right and 
requires at least Full Control NTFS rights to the Performance Canvas installation 
folder and all sub-folders. 

Data Pump and SSAS are Not on the Same Server 
If the data pump and SSAS are not on the same server, install the following prerequisite software 
components: 

 Microsoft Core XML Services (MSXML) 6.0 (required to install the OLE DB Provider) 

 If using SQL Analysis Services 2005: Microsoft SQL Server 2005 Analysis Services 9.0 
OLE DB Provider.  
See: http://www.microsoft.com/Downloads/details.aspx?familyid=50B97994-8453-4998-
8226-FA42EC403D17&displaylang=en 

 If using SQL Analysis Services 2008: Microsoft SQL Server 2008 Analysis Services 10.0 
OLE DB Provider. 
See: http://www.microsoft.com/downloads/details.aspx?familyid=228DE03F-3B5A-428A-
923F-58A033D316E1&displaylang=en  

 IMPORTANT: You mustdownload the correct platform version (x86 or x64) to 
match your installation of SQL Analsysis Services and IIS. 

Modify the msmdpump.ini file to point to the location of the SSAS server: 

<ConfigurationSettings> 
<ServerName>localhost</ServerName> 
<SessionTimeout>3600</SessionTimeout> 
<ConnectionPoolSize>100</ConnectionPoolSize> 
</ConfigurationSettings> 

Test the Data Pump Configuration 
You must complete the following actions to test the data pump confirmation: 
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 Test the URL. 

 Test the connection using SQL Management Studio. 

 Test the connection using Excel. 

Test the URL 

To test the URL to ensure that the data pump is set up correctly, complete the following 
steps: 

1. Access the data pump URL (http://<IISServer>/<OLAPVirtual>/msmdpump.dll.  

2. Go to Internet Explorer Advanced Settings.  

3. Remove the checkmark by the Show friendly HTTP error messages option. The 
following information displays:  

 <soap:Envelope xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/"> 
 <soap:Body> 
 <soap:Fault xmlns="http://schemas.xmlsoap.org/soap/envelope/"> 
 <faultcode>XMLAnalysisError.0xc10e0002</faultcode>  
 <faultstring>Parser: The syntax for 'GET' is incorrect.</faultstring>  
 <detail> 
 <Error ErrorCode="3238920194" Description="Parser: The syntax for 'GET' is incorrect." 
Source="Unknown" HelpFile="" />  
 </detail> 
 </soap:Fault> 
 </soap:Body> 
 </soap:Envelope> 

  

 
 
Even though the information above reflects an error, this is the message that indicates 
that the Data Pump is configured correctly. 

  

 
If the above does not display in the browser, check the Application Event log on the 
server for errors. 
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Use SQL Management Studio to Test the Connection 
You can use HTTP and SQL Server Management Studio to test the data pump connection to the 
Vision Analysis Cubes. 

You cannot test the connection using SSMS if you chose Windows Integrated Authentication. 
However, you can set the initial IIS virtual directory permissions for anonymous and test the 
configuration (remember to change the Anonymous access account to a user account that has 
read access to the Vision Analysis Cubes), and then reset back to Windows Integrated 
Authentication when testing has been completed. 

Use Excel to Test the Connection 
You can use HTTP and Microsoft Excel to test the data pump connection to Vision Analysis 
Cubes. See the Configuring Vision Analysis Cubes for Internet Accessibility Guide on Customer 
Care Connect for more information. 

If you use Windows Integrated Authentication, you cannot use Excel to test the connection. 
However, you can set the initial IIS virtual directory permissions for anonymous and test the 
configuration (remember to change the Anonymous access account to a user account that has 
read access to the Vision Analysis Cubes), and then reset back to Windows Integrated 
Authentication when testing has been completed. 

Configure the Performance Canvas Software 
You must configure the Performance Canvas software for the following: 

 Security — How users authenticate to the Performance Canvas application. 

 Roles — What access users have to the Performance Canvas application. 

 Data sources — How Performance Canvas accesses the Deltek Vision Analysis Cubes. 

Before you configure the security, roles, and data sources, you must launch the Administration 
console to configure the Performance Canvas. 

Launch Admin Console 
To launch the Performance Canvas Admin Console, enter the following URL: 
http://<PerformanceCanvasServer>:<Port>/app/admin 

For example, if the server name is PerformanceCanvas and you configured the Performance 
Canvas software to use port 81, the URL is http://PerformanceCanvas:81/app/admin.  

The Admin Console displays several tabs across the top: 
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Configure General Settings 
The General tab displays the following options: 

 Flush cache — Use this option when: 

o You move between a development environment and a production environment 
where cubes have the same name (in this case the main cache is updated but 
not the session caches. When you flush the cache, make sure that everyone 
moves over to the new environment.) 

o You changed security constraints for the cube without processing it and want the 
updates to be reflected immediately. 

o You changed the roles and their members and want the changes to be reflected 
immediately. 

 Set loglevel — Use this option for debugging purposes. 

 Change locale — Use this option to change your locale if appropriate. 

 Register PERFORMANCE CANVAS 2009 — Enter the Product Key received for the 
Performance Canvas software and click Register. 
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Configure Security 
The Performance Canvas software supports the following methods of client authentication: 

NTLMv2 — This security requires that you configure your domain accounts to provide the 
appropriate level of access to the Performance Canvas software through Roles and 
Approvals. Deltek recommends that you use NTLMv2 authentication for ease of 
deployment. 
 
IMPORTANT NOTE: If you will be using NTLM security with Windows Server 2008 R2, 
you must add the following line to the zenith.properties file: 
 
dsp.security.ntlm.newprovider=true 

 
NOTE: If you have users in multiple trusted domains, you must obtain a list of domain 
controller hostnames from each of the domains and add the following line to the 
zenith.properties files: 

dsp.security.dclist=dchostname1,dchostname2, etc. 
 
Basic Authentication — This security requires that you create user accounts and 
passwords manually in the Performance Canvas software. You should only use this 
option in non-domain environments. 

 Anonymous Access — If you use Anonymous access, you cannot control access to the 
DSP software through Roles or Approvals. Anonymous access is not recommended 
because it provides all users with the same level of access to all canvases, comments 
(annotations) and viewpoints, as well as the designer. Users with this level of access can 
also modify existing canvases.  

 If you use Anonymous access, you must implement the following settings in the 
Performance Canvas to limit user access: 

o Disable listing of canvases of Performance Canvas homepage: This ensures 
users do not have access to all available canvases, which is the default behavior 
when using Anonymous Access. Complete the following steps to disable the 
listing of canvases on the Performance Canvas homepage: 

1. Browse to the Performance Canvas installation directory. 
2. Use Notepad to open the zenith.properties file. 
3. Append the following setting to the end of the file and save your 

changes: 
dsp.security.listcanvases=false 
 

4. Restart the Performance Canvas windows service. 

o Disable the ability to use the menu items to access the Performance 
Canvas Designer:  You must disable both the Designer button on each canvas 
menu bar, and the Open Designer button on the Performance Canvas 
homepage. This disables user access to the Performance Canvas Designer and 
ensures users do not have full access to the Performance Canvas Designer, 
which is the default behavior when using Anonymous Access. Complete the 
following steps to disable the Performance Canvas Designer: 

Browse to the Performance Canvas installation directory. 

Navigate to the Store\Settings folder. 
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Use Notepad to open the app.properties file. 

Remove the following lines and save your changes: 
dsp.designer.title=Performance Canvas Design Studio 
dsp.designer.gwt=com.dsp.designer.ZenithDesigner 
dsp.designer.css=ZenithDesigner.css 

Restart the Performance Canvas windows service. 

 Windows Integrated Authentication — Windows Integrated Authentication is not 
recommended. It requires that you configure Kerberos delegation and only works if the 
Microsoft OLAP Data Pump is configured on the SSAS server. 

These authentication methods determine how the client authenticates to Performance 
Canvas only, not to SSAS. Authentication to SSAS is controlled through the Microsoft OLAP 
Data Pump access account, which requires read only access to the Vision Analysis Cubes. 

Optional: Map SSAS roles to Performance Canvas Roles  
The Performance Canvas software supports the mapping of SSAS/OLAP users/roles to 
Performance Canvas roles.  

 With Anonymous Access mapping you assign a single SSAS account for access.  

 With NTLMv2, you can provide multiple accounts with different access levels to the 
Vision Analysis Cubes and map those users to Performance Canvas roles.  

Windows Integrated Authentication is the only method to provide direct user authentication 
mapping. For example, Joe authenticates to Performance Canvas and SSAS as Joe. However, 
this is also the most difficult method to deploy because it requires that you configure Kerberos 
Delegation, and the Microsoft Data Pump must reside on the SSAS server. For these reasons, 
this is currently not recommended.  
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Configure Roles 
If you use NTLMv2 or Windows Integrated Authentication, you are presented with a list of your 
domain users and groups which you can use to assign to the various roles provided in 
Performance Canvas. You must add your Administrative account(s) and also the windows 
account that is running the Performance Canvas service as administrators. Most users need 
Business User role access in order to use the drill-down functionality of the software. 

  

 In large domains (> 1,000 objects), it may take additional time for the Roles tab to display. 
Refer to Role Configuration on page 42 additional information. 
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Configure Data Sources 

To configure the information that is required for Performance Canvas to access the Deltek 
Vision Analysis Cubes, complete the following steps: 

1. Click the Data Sources tab in the Admin Console. 

2. Expand the All Datasources folder. Note that a sample is already listed 
(olap.performancecanvas.com). 

3. Right-click All Datasources and select Add Datasource. 

4. Enter the URL for the Microsoft OLAP Data Pump. For example, 
http://<IISServer>/<OLAPVirtual>/msmdpump.dll).  

5. Click OK. The name of your IIS server now displays in the list. 

6. Click the (+) sign to expand the server. The SSAS server name displays. 

7. Click the (+) sign again to see the cube database (for example, Deltek VisionAnalysis). 

8. Click the (+) sign again to see the Vision Analysis Cubes (General Ledger and Project 
OLAP Cubes). 

9. Click the General Ledger OLAP Cube option to add that cube to the Performance 
Canvas configuration. You receive a message when the cube is added. 

10. Repeat step 9 for the Project OLAP Cube. If you receive a message stating that adding 
the cube failed, or if the process seems to delay, you must refresh the browser and try 
adding the cube again. 
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Configure Approval 
The Performance Canvas installation consists of many different objects. You must import these 
objects and change approvals before you can access them from either Performance Canvas or 
Vision. These objects include: 

 Gems 

 Slicers 

 Canvases 

The next section, “Deploy Sample Canvases,” details how to use the Deltek Vision Resource Kit 
to import the Deltek sample objects. You must mark each canvas as Approved before it is 
accessible within the Vision Web dashparts. It is not necessary to mark the gems and slicers as 
approved or published. 

If you mark a canvas as Published, it is available in both the Performance Canvas interface and 
the Vision Web dashparts. 
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Deploy Sample Canvases 
After the Performance Canvas software is installed and operational, you must use the Deltek 
Vision Resource Kit to deploy the supplied Deltek Vision sample objects. 

To deploy the sample canvases, complete the following steps: 

1. Make sure you have installed the Deltek Vision database tier on the server that hosts 
SQL Server Analysis Services. If you are running Vision 5.1, you must also install the 
Performance Canvas hot fix.  

2. Click Start » All Programs » Deltek Vision » Deltek Vision Resource Kit to start the 
Deltek Vision Resource Kit. If you are using Windows Server 2008 and 2008 R2, you 
must run the Resource Kit as an Administrator. Right-click the shortcut and choose Run 
as Administrator. 

3. Click the Advanced tab. 

 

4. Click Performance Canvas. The Database Server Logon dialog box automatically 
displays. 
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5. Select the Windows Integrated option. NOTE: Windows Integrated is required for this 
functionality.  

6. Click OK. The Advanced tab displays. 

7. Click the Performance Canvases tab.  

 

 

8. Enter the base URL for your Performance Canvas deployment. Use the following format: 
http://<PerformanceCanvasServer>:<Port>  
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9. Click the Import Canvases button to import the Deltek sample canvases to your 
Performance Canvas server. The canvas files that are imported are on the database 
server under <Vision Installation folder>:\Canvases. When you click Import, the 
canvases are moved to the \Canvases\imported folder with a date and timestamp. If you 
need to re-import the canvases, you must copy them from the appropriate imported folder 
to the root of the Canvases folder. 

10. Select the appropriate language for the canvases which must match the language 
chosen for the Deltek Vision Analysis cubes. This will ensure that the language specific 
system labels are applied to the canvases. 

11. If you customized your Deltek system labels, you must also click the Apply System 
Labels to Canvases button to ensure that these custom labels are applied to your 
canvases. A backup folder is created when system labels are applied under the 
\Canvases folder. 

If you used the Performance Canvas designer to create canvases, you can also use the Export 
Canvases button to export these canvases for backup purposes. The canvases are stored as 
text files in <drive>:\Program Files\Deltek\Vision\Canvases. If you encounter an error during 
these steps, you can click File » View Log to review the logs. 

After you import the sample canvases, you need to access the Performance Canvas Admin 
Console and mark the imported gems, slicers, and canvases as Approved so that users can 
access them in Vision. 

Mark Canvases as Approved 
To mark canvases as approved, complete the following steps: 

1. Launch the Performance Canvas Admin console. 

2. Click the Approval tab and the Canvas subtab. 

3. Click the Status column for each canvas and select Approved.  
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4. After all canvases are marked Approved, click Save to save your changes. 

NOTE: If you wish to be able to access the canvases directly in the Performance Canvas 
application (not just as Vision web dashparts, the approval status must be Published. 

5. You must test the published canvases. Open the Performance Canvas base URL (for 
example, http://server:81). 
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6. Double-click a canvas. If everything is configured properly, a canvas displays. 
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Configure Performance Canvas Server in Weblink 
On the General tab for each database that will use Performance Canvas, enter the Performance 
Canvas Home URL. The format is as follows: http://<PerformanceCanvasServer>:<Port>  

 

Test your Performance Canvas Installation/Configuration 

To test your configuration, complete the following steps: 

1. Log in to Vision. 

2. Access the Vision Dashboard. 

3. Click Configure » Add Web Dashpart. The Add Web Dashpart dialog box displays. 
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4. Click the Address Type drop-down list and select Performance Management 
Canvases. 
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If you do not see Performance Management Canvases in the drop-down list, make sure 
of the following: 

 The URL for the Performance Canvas server is correctly defined in Weblink  

 The Performance Canvas service is running and that you can access the 
Performance Canvas URL directly. 

 You have marked the canvases as either APPROVED or PUBLISHED in the 
Approvals tab of the Performance Canvas Administration console. 

Upgrade the Performance Canvas 09 Software 
The process to upgrade to a newer version of Performance Canvas 09 is seamless; when you 
run the new Performance Canvas 09 installer, your installation is automatically upgraded. 
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Chapter 2: Troubleshoot Your Configuration 

Refer to the following sections for detailed information on how to resolve configuration issues for 
your Performance Canvas installation. 

OLAP Data Pump 
The following error indicates that the Microsoft SQL Server 2005 Analysis Services 9.0 OLE DB 
Provider is not installed on the server running the Microsoft OLAP Data Pump: 

 

To fix this error, install Microsoft SQL Server 2005 Analysis Services 9.0 OLE DB Provider on the 
server running the Microsoft OLAP Data Pump. 

Security 
When you configure NTLMv2 or Windows Integrated Authentication, you select the security 
method and save. After you do so, you must add your domain user to the Performance Canvas 
Administrator Role before you restart the Performance Canvas service. If you do not, the next 
time that you attempt to access the Admin Console, a warning message displays: 
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To reset the authentication method to Anonymous, complete the following steps: 

1. Stop the Performance Canvas service. 

2. Edit the zenith.properties file to change dsp.security.provider=NTLM to 
dsp.security.provider=ANON. 

3. Save your changes and restart the service. 

4. Access the Admin console and complete the following actions: 

 Change the security back to the default. 

 Add your domain user to the DSP Administrator Role. 

 

If you are using NTLM Security with Windows Server 2008 “R2”, the Performance Canvas 09 
application may crash with an event log message similar to the following: 
 
Log Name:      Application 
Source:        Application Error 
Date:          4/5/2011 10:11:39 AM 
Event ID:      1000 
Task Category: (100) 
Level:         Error 
Keywords:      Classic 
User:          N/A 
Computer:      WOBAPDEV1.ads.deltek.com 
Description: 
Faulting application name: java.exe, version: 6.0.120.4, time stamp: 0x4971aa88 
Faulting module name: ntdll.dll, version: 6.1.7600.16695, time stamp: 0x4cc7b325 
Exception code: 0xc0000374 
Fault offset: 0x00000000000c6ab2 
Faulting process id: 0xd88 
Faulting application start time: 0x01cbf38dca9f5a66 
Faulting application path: C:\Program Files\Performance Canvas 2009 - 2.3.207 
(MCMCML)\runtime\bin\java.exe 
Faulting module path: C:\Windows\SYSTEM32\ntdll.dll 

 

In order to resolve this error when using NTLM security with Windows Server 2008 “R2” you must 
add the following line to the zenith.properties file: 
 
dsp.security.ntlm.newprovider=true 

Role Configuration 
The following issues can occur with a large number of users. 

Too Many Users 

When there is a large domain, you may not be able to retrieve users and groups listed in 
Performance Canvas. The following error message displays: 
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If you have too many users, you can use the search feature to search for your users or groups. 
No wildcards are necessary when you search. 

Script Running Slowly 

In environments with large numbers of users and groups in the Active Directory, you may 
repeatedly receive the following message when you access the Roles tab: 

A script on this page causes Internet Explorer to run slowly. If it continues to run, 
your computer may become unresponsive. Do you want to abort the script? 

To avoid this message and allow the scripts to run to completion, complete the following 
steps: 

1. Use the registry editor to open the following key:  

HKEY_CURRENT_USER\Software\Microsoft\InternetExplorer\Styles 

If the Styles key is not present, create a new key that is called Styles.  

2. Create a new DWORD value called MaxScriptStatements under this key and set the 
value to zero (0).  

Nested Domain Groups 
If you grant an Active Directory group access to a Performance Canvas role and users are 
members of a group that is nested—that is a member of another group to which you granted 
access—those users are not granted access. In this instance, grant access to your users or the 
nested groups directly. 

Data Sources 
The following errors can occur with data sources: 

 If you see a loading message but the SSAS server name does not display, then there 
may be a problem with the authentication between the OLAP virtual directory in IIS. 
Complete one of the following: 

 If you use Anonymous access, make sure that you have changed the Anonymous 
Access account to a domain account that has read access to the Vision Analysis Cubes.  

 If you use Windows Integrated Authentication, make sure that the Performance Canvas 
service is running as a domain user with read access to the Vision Analysis Cubes. 

 If the message Cube Load Failed displays, the service account does not have write 
access to the Performance Canvas installation folder.  
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Errors Displaying Canvases 
If you receive errors when requesting any/all canvases and the canvas objects do not display at 
all, the most likely reason is that system labels were not applied properly to the Canvases.  View 
the canvases on the approval tab of the Admin Console and ensure that none of the canvases 
have a tilde (~) in the name of the canvas. The tilde is what is used as a placeholder for the 
system labels and no tildas should be present in the canvas names. If you see any tildas, review 
the resource kit log file and contact technical support for assistance. 

If you receive errors as above but some of the objects on the canvases are displayed in the 
background, the most likely reason is throughput on the OLAP data pump.  You may also have 
received an http 503 message in the error.  The solution to this problem is to enable multiple 
worker processes for the application pool servicing the OLAP data pump, also known as creating 
a web garden.  Multiple worker processes can be enabled on the Advanced Settings of the IIS 
Application Pool.  A general rule of thumb is to establish 2 worker processes per physical CPU 
core in the server. 

Application Errors 
If you are running Internet Explorer 7 on the client workstation that is accessing the Performance 
Management Canvases through the Deltek Vision Dashboard interface you may receive the 
following error intermittently if Disable Script Debugging (Other) is unchecked in Internet Explorer 
Advanced Options.  Selecting No to not debug several times will allow the canvas to display 
properly.  Disabling Script Debugging (Other) in IE Advanced Options (making sure the box is 
checked) will alleviate this issue. 
 
NOTE: Internet Explorer 8 (or higher) is recommended. 
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Appendix A: Configure Performance Canvas for 
SSL 

The Performance Canvas application uses the Apache© Tomcat web server as its HTTP engine 
and must be configured for use with SSL. Complete the following procedures to configure the 
Performance Canvas application for use with SSL.  

Establish the Java Keystore and Import Certificates 
1. Open a command prompt to the following location which has the keytool application: 

D:\Program Files\Performance Canvas\Runtime\Bin 

2. Use the following command to create the JKS (Java Keystore) and local certificate: 

keytool -genkey -alias tomcat -keyalg RSA -keystore "D:\Program 
Files\Performance Canvas\.keystore" 

3. Name the keystore file .keystore and save it in the root of the Performance Canvas 
installation directory.  

4. Change the path in the above command to match your installation.  

5. When you are prompted to provide information typical of requesting an SSL certificate, 
enter the following: 

 First and Last name — Enter the name of the server or FQDN being used. 

 Password — Enter a password for the keystore. 

6. Create a certificate signing request (CSR) to submit to the CA (Verisign, Thawte, etc.) 
with the following command: 

keytool ‐certreq ‐keyalg RSA ‐alias tomcat ‐file certreq.csr ‐keystore "D:\Program 
Files\Performance Canvas\.keystore" 

 

The Java Key Store (JKS) is not compatible with certificates issues from a Microsoft Domain 
Certificate authority. 

 

7. When you receive your certificate and certificate root chain, use the following command 
to import the chain certificate into the JKS: 

keytool ‐import ‐alias root ‐keystore "D:\Program Files\Performance Canvas\.keystore" ‐
trustcacerts ‐file <your_certificate_filename> 

Use the following command to import the certificate: 

keytool ‐import ‐alias tomcat ‐keystore "D:\Program Files\Performance Canvas\.keystore" 
‐trustcacerts ‐file <your_certificate_filename>  

Modify Performance Canvas Configuration File 
After you create the Java keystore, add the following to the zenith.properties file in the root of the 
Performance Canvas installation directory: 
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dsp.security.ssl=true 
dsp.security.ssl.protocol=TLS 
dsp.security.ssl.keystorepass=<keystore password> 

You may also want to change the dsp.port value to be the default Tomcat SSL port which is 8443 
but this is not required. 

Modify the Performance Canvas Home URL in Weblink 
You must modify the Performance Canvas Home URL in Weblink to include the https reference 
and any port change. For example: https://performancecanvas.company.com:8443 

  

 

The runtime version of Apache Tomcat being used does not support both http and https ports. So if 
you use SSL, it will be used whether Vision is using SSL or not. 

Modify Internet Explorer Security Settings 
To use NTLMv2 as the Performance Canvas security method and an FQDN for the Performance 
Canvas URL, you must complete the following: 

1. From Tools » Internet Options » Security, add the Performance Canvas Home URL to 
your Trusted Sites List. 

2. Open Trusted Sites security. 

3. Under User Authentication » Logon, select the Automatic logon with current user 
name and password option. If you do not select this option, Internet Explorer prompts 
you to enter your credentials when you attempt to access the canvases.  
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Resources 
Refer to the following resources for additional information: 

 Tomcat SSL Documentation link – http://tomcat.apache.org/tomcat‐5.5‐doc/ssl‐howto.html  

 Helpful Keytool commands – http://www.sslshopper.com/article‐most‐common‐java‐keytool‐
keystore‐commands.html 

 Verisign Certificate Instructions – https://knowledge.verisign.com/support/ssl‐certificates‐
support/index?page=content&id=SO9314  
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Appendix B: Configure Performance Canvases for 
Load Balancing 

Pre-requisites  
You must use Performance Canvas version 2.3.213 or later to use these features. 

Configure Performance Canvases for Load Balancing 
To configure load balancing with Performance Canvases, you must create a shared location for 
the Store folder. This folder contains the Performance Canvas objects (canvases, gems, slicers, 
etc.). For example, if you have two load balanced Performance Canvas servers, you will need 
another server to host the shared store folder; a file server, or other server not involved in the 
load balancing. 

To configure Performance Canvas for load balancing, complete the following steps:  

1. Refer to Install Performance Management Canvases on page 4 to install and 
configure the first Performance Canvas server (including importing the canvases 
using the Resource Kit and applying system labels). 

 

If you are using Anonymous Access, you will need to configure a service account for the 
Performance Canvas service that will have rights to the shared store folder. 

2. Stop the Performance Canvas service. 

3. Locate the Store folder in the root of the Performance Canvas installation 
directory (for example, C:\Program Files\Performance Canvas\store). Copy the 
Store folder to the server that you will use to host the shared folder.  

4. Enable a file share at that location. Do not share the Store folder itself, but share 
the folder immediately above it.  

5. Grant NTFS and Share permissions to the Performance Canvas service account 
to the files and file share. 

6. Modify the zenith.properties file as follows: 

dsp.store.path=<UNC or mapped drive to shared store folder> (for example, 
\\camqasql2k5temp\<SharedDirectory>\store\) 

dsp.store.path.custom=true 

7. Rename the Store folder on the Performance Canvas server to StoreOLD or 
something similar. 

 

A new store folder will be created on the Performance Canvas server when the service is started, 
but it will only contain a temporary working folder from this point on. 

8. Start the Performance Canvas service and ensure that you can view your 
Performance Management canvases in Vision. 

After successful installation, complete the following steps to have multiple Performance 
Canvas servers in a load balanced configuration:  
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1. Install and configure additional Performance Canvas servers identically to the 
first server including the authentication method and TCP/IP port.   

 

It is not necessary to perform the steps in the Deltek Vision Resource Kit on the additional servers 
since the canvases would have already been imported into the Store folder with the first installation. 

2. Configure Windows Network Load Balancing or use other hardware or software 
load balancing devices on the Performance Canvas servers.  

3. Set the Affinity to Single in the load balancing configuration. 

4. In the Weblink Utility, enter the VIP (virtual IP address) of the load balanced 
cluster on the Performance Canvas Home URL. 

 

Upgrade Load Balanced Performance Canvas Software 
The instructions that follow in this appendix are specific to upgrading Performance Canvas 
servers that are configured for load balancing and have a shared store directory.  If you are 
running Vision with Performance Canvas 07, you must upgrade to Vision 6.1 SP4 with hotfix # 30 
in order to upgrade to Performance Canvas 09.   

  

 
The upgrade process is not really an upgrade process from a software installation 
standpoint. Instead, you either uninstall Performance Canvas 07 after backing up the 
necessary Performance Canvas objects or you can perform a side by side installation if 
you wish to compare the two versions. Both of these options do require a clean 
installation of Performance Canvas 09 as detailed later in this section. 

  

Option #1 - Uninstall Performance Canvas 07 
First, make sure to backup the shared “store” directory used by all servers in the configuration 
and then rename the store directory to store_PC07.  Next, perform the following steps on all 
servers in the load balanced configuration: 

1. Uninstall the Performance Canvas 07 service as the 09 installation will install the same 
service name and will conflict. Make sure to make note of the service account and other 
pertinent configuration information (security and role configuration, etc.) before 
performing the uninstall.   

a. Stop the Performance Canvas service 

b. Browse to the location of the Performance Canvas 07 installation directory 
(typically c:\Program Files\Performance Canvas) 

c. In the \bin directory double-click the Uninstall.bat file to perform the uninstall of 
the service 

d. Review the Services.mmc to ensure the Performance Canvas service is 
removed. 

2. Back up the Performance Canvas 07 installation directory (\Program Files\Performance 
Canvas). 

3. Uninstall Performance Canvas 07 from add/remove programs (Server 2003) or Programs 
and features (Server 2008). 
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4. Make sure the installation directory is completely removed. If not, delete the Performance 
Canvas directory. 

5. Perform a new installation of Performance Canvas 09 (refer to Install Performance 
Management Canvases on page 4 for more information). 

6. After the installation is complete, make of copy of the Store directory under the 
Performance Canvas installation directory. 

7. Make a copy of the zenith.properties file from the new installation.   

8. From the backup of Performance Canvas 07 completed in Step 2, complete the following: 

a. Copy the zenith.properties file as this file contains your license key information. 

b. Copy over the following directories from the backup \Store folder to \Performance 
Canvas\store, over-writing when prompted: 

 annotation 

 canvas 

 chart 

 filter 

 gem 

 slicer 

 table 

 tag 

 viewpoint 

Additionally, copy over the store\settings\cubes.xml. This contains your datasource 
configuration. 

9. Uninstall and then reinstall the Performance Canvas 09 service. 

a. Stop the Performance Canvas service if it is started. 

b. Uninstall the Performance Canvas 09 service by double-clicking bin\uninstall.bat. 

c. Modify the Memory Settings for the service as outlined on page 12. 

d. Reinstall the Performance Canvas service. 

10. Modify the following zenith.properties settings as appropriate for your installation. For 
example, modify the dsp.port value to the port used by Performance Canvas 07. 

11. Configure the service account for Performance Canvas to be the same account used for 
Performance Canvas 07. 

12. Start the Performance Canvas 09 service. 

13. Launch the Admin console for Performance Canvas 09 to configure your installation 
including the following. Refer to Configure the Performance Canvas Software on page 26 
for more information. 

a. Configuring security (NTLM v. Anonymous). 

b. Adding users to roles (make sure to add your admin account and the service 
account to the Administrators role). 

c. Verifying datasource configuration (cubes.xml). 
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d. Verifying canvas approvals. 

14. Once the new Performance Canvas 09 installation has been fully configured, perform the 
following steps: 

a. Stop the Performance Canvas 09 service. 

b. Copy the store folder from the Performance Canvas 09 installation directory to 
the shared store path as it was in Performance Canvas 07. 

c. Rename the store folder on the Performance Canvas server to store_PC09. 

d. Modify the zenith.properties file to add the following configuration options: 

i. dsp.store.path=<UNC or mapped drive to shared store folder> (for 
example, \\camqasql2k5temp\<SharedDirectory>\store\) 

ii. dsp.store.path.custom=true 

e. Start the Performance Canvas 09 service and verify functionality. 

Option #2 – Perform Side by Side Installation 
First, make sure to backup the shared “store” directory used by all servers in the configuration 
and then rename the store directory to store_PC07.  Next, perform the following steps on all 
servers in the load balanced configuration: 

1. Uninstall the Performance Canvas 07 service as the 09 installation will install the same 
service name and will conflict. Make sure to make note of the service account and other 
pertinent configuration information (security and role configuration, etc.) before 
performing the uninstall. 

a. Stop the Performance Canvas service. 

b. Browse to the location of the Performance Canvas 07 installation directory 
(typically c:\Program Files\Performance Canvas). 

c. In the \bin directory double-click the Uninstall.bat file to perform the uninstall of 
the service. 

d. Review the Services.mmc to ensure the Performance Canvas service is 
removed. 

2. Back up the Performance Canvas 07 installation directory (\Program Files\Performance 
Canvas. 

3. Perform a new “custom” installation of Performance Canvas 09. Make sure to change the 
installation location to \Program Files\Performance Canvas 2009 and not overwrite your 
07 installation (refer to Install Perfromance Management Canvases on page 4 for more 
information). 

4. After the installation is complete, make of copy of the "Store" directory under the 
Performance Canvas installation directory. 

5. Make a copy of the zenith.properties file from the new installation.   

6. From the backup of Performance Canvas 07 completed in Step 2, complete the following: 

a. Copy the zenith.properties file as this file contains your license key information. 

b. Copy over the following directories from the backup \Store folder to \Performance 
Canvas\store, over-writing when prompted: 

 annotation 
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 canvas 

 chart 

 filter 

 gem 

 slicer 

 table 

 tag 

 viewpoint 

Additionally, copy over the store\settings\cubes.xml. This contains your datasource 
configuration. 

7. Uninstall and then reinstall the Performance Canvas 09 service. 

a. Stop the Performance Canvas service if it is started. 

b. Uninstall the Performance Canvas 09 service by double-clicking bin\uninstall.bat 

c. Modify the Memory Settings for the service as outlined on page 12. 

d. Reinstall the Performance Canvas service 

8. Modify the following zenith.properties settings as appropriate for your installation making 
sure to choose a port that is different from Performance Canvas 07 so they will not 
conflict (for example, if 07 is using port 81, configure 09 to use port 82) 

9. Configure the service account for Performance Canvas to be the same account used for 
Performance Canvas 07. 

10. Start the Performance Canvas 09 service 

11. Launch the Admin console for Performance Canvas 09 to configure your installation 
including the following. Refer to Configure the Performance Canvas Software on page 26 
for more information: 

a. Configuring security (NTLM v. Anonymous) 

b. Adding users to roles (make sure to add your admin account and the service 
account to the Administrators role) 

c. Verifying datasource configuration (cubes.xml) 

d. Verifying canvas approvals 

12. Once the new Performance Canvas 09 installation has been fully configured, perform the 
following steps: 

a. Stop the Performance Canvas 09 service 

b. Copy the store folder from the Performance Canvas 09 installation directory to 
the shared store path as it was in Performance Canvas 07 

c. Rename the store folder on the Performance Canvas server to store_PC09 

d. Modify the zenith.properties file to add the following configuration options: 

i. dsp.store.path=<UNC or mapped drive to shared store folder> (for 
example, \\camqasql2k5temp\<SharedDirectory>\store\) 

ii. dsp.store.path.custom=true 
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e. Start the Performance Canvas 09 service and verify functionality 

Additional steps for side by side comparison after Performance Canvas 09 installation: 

13. Modify the Performance Canvas 07 service.properties file to make service 
name/description unique 

dsp.service.name=Performance Canvas 2007 

dsp.service.description=Performance Canvas 1.3.0.7 

dsp.service.minmem=128M 

dsp.service.maxmem=1024M 

14. Re-install the Performance Canvas 07 service by double clicking InstallService.bat in the 
Performance Canvas 07 installation directory. 

15. Modify the zenith.properties file to change the shared store path to the renamed store 
folder (for example, \\camqasql2k5temp\<SharedDirectory>\store_PC07\ 

16. Start Performance Canvas 07 service and verify functionality 

 

Once you have completed your comparison of Performance Canvas 07 and 09, stop and uninstall 
the Performance Canvas 07 service and remove the directories if appropriate. 

 

 

 

 



 

 

 


